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PURPOSE 
The following guide provides step-by-step instructions on how to complete the OLB set-up, 

enabling terminals to connect to the OTCnet Online Application without Java Applets.  

Note: Many of the Printable Job Aids included in this guide are related to Check Capture. The 

steps presented in these guides enable users to set-up their OLB profiles and enable the OLB 

to support both Card Processing and Check Capture. 

SECTION I: PREPARE FOR THE OLB SETUP  
Complete the following steps to ensure system prerequisites have been met. 

1. Check system requirements to complete any necessary configurations.  

• Refer to the OTCnet System Requirements and Reference Guide:  

https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf  

• In the Guide, review the following sections: General Requirements (page 3), 

Check Processing Requirements (page 4) and Check Capture Hardware/Scanner 

Requirements (pages 6-7), OTCnet Card Processing Requirements (page 8) 

 

2. Confirm the installed OTCnet Firmware is 4.3.0.  

• To upgrade the Firmware, refer to the Configuring Check Capturing Online: 
Download Firmware Printable Job Aid (PJA):  
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_download_

firmware.pdf 

• To install the Firmware, refer to Configuring Check Capturing Online: Install 

Firmware PJA for installation guidance:  

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_install_firm

ware.pdf 

 

Note: Firmware is required for Check Processing; it is not required for Card Processing. 

 

3. Modify Internet Explorer Internet Settings as needed. Skip this step if using Google 

Chrome. 

• Refer to the OTCnet System Requirements and Reference Guide:  

https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf  

• In the Guide, review the following section: OLB Prerequisites (page 4).  

  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
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https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_download_firmware.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_install_firmware.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_install_firmware.pdf
https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf


OTCnet Local Bridge (OLB) 
Configuration and Setup Guide 

 

6 
 

SECTION II: DOWNLOAD AND INSTALL THE OLB APPLICATION 
Once the system is prepared for OLB installation, complete the following steps to install the 
application.   

1. Download the OLB Application Installation Package.  

• For guidance, refer to the Configuring Check Capturing Online: Download the 

OTCnet OLB Application Package PJA:  

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_download_

olb.pdf 

Note: Only the Check Capture Administrator (CCA) and the Card Administrator (CA) can 

download the OLB Application Installation Package. After the OLB Applications Installation 

Package is downloaded, any user role with Windows Administrator privileges can complete the 

installation and setup of the OLB. 

 
2. Install the OLB Application.   

• For guidance, refer to the Configuring Check Capturing Online: Install the OLB 

Application Installation file PJA:  

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_install_OL

B.pdf  

• It is recommended to use the default Server Port Settings during the OLB 

installation process. If you would like to modify Server Port Settings, contact the 

OTCnet Customer Support Team for assistance. 

 

Note: Each user will need to download and install the OLB application installation package for 

access. For multiple users assigned to a shared terminal, it is recommended that the Agency IT 

Administrator use the mmc.exe approach to install the OLB application on a shared 

workstation. This will bypass the need for each user to install the OLB application under their 

individual workstation login. Please reference pages 12-16 on how to install the OLB certificate 

for all Windows users on a workstation.  

SECTION III: CREATE AN OLB PROFILE AND IMPORT OLB 
CREDENTIALS 
Each Check Capture, Check Processing, and Card Processing user (e.g., Check Capture 
Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture 
Operator, Card Administrator or Card Operator) must complete the following steps to create 
individual OLB credentials for access.  

1. Create the OLB Profile.  

• For guidance, refer to the Configuring Check Capturing Online: Create the 

OTCnet OLB Profile PJA:  

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_create_o

lb_profile.pdf  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_download_olb.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_download_olb.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_install_OLB.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_install_OLB.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_create_olb_profile.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_create_olb_profile.pdf
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Note: The OLB password never expires. To reset the password, a new OLB profile will need to 

be created. Users’ OTCnet Online passwords are not connected or tied to their OLB passwords. 

Therefore, updated OTCnet Online passwords do not impact or change users’ OLB passwords.  

2. Import OLB Credentials.  

• To ensure successful import, refer to the Configuring Check Capturing Online: 

Import OTCnet OLB Credentials PJA: 

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_import_o

lb_credentials.pdf  

Note: Users who access OTCnet on multiple terminals can save their OLB credential file to a 

shared folder (if accessible). Users can then import their unique OLB credential on each 

terminal. 

SECTION IV: START THE OLB 
Each user will need to complete the following steps to launch the OLB and resume Check 
Processing, Check Capture, and Card Processing activities.  

1. Start the OLB application.  

• To ensure successful launch of the OLB, refer to the Basic Security: Start and 

Stop the OTCnet OLB Application PJA: 

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/905/sims/pja_start_sto

p_olb.pdf  

1. There is no “timeout” with the OLB application (i.e., a suspension or break in 

OTCnet activity). Therefore, the OLB application will stay connected unless one 

of the following occurs:  

o The user logs out of the workstation (Windows session)  

o The terminal is turned off, restarted, or rebooted  

o The user stops the OLB application on the terminal  

2. Log into OTCnet Online.  

2. For guidance, refer to the Basic Security: Log into the OTCnet Online PJA 
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/905/sims/pja_log_on_

otcnet.pdf  

  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
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https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_import_olb_credentials.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/56/sims/pja_import_olb_credentials.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/56/sims/pja_import_olb_credentials.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/905/sims/pja_start_stop_olb.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/905/sims/pja_start_stop_olb.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/905/sims/pja_log_on_otcnet.pdf
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/905/sims/pja_log_on_otcnet.pdf
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SECTION V: OLB TROUBLESHOOTING 
To remedy common challenges when completing the OLB configuration and set-up, explore and 
consult the compiled troubleshooting topics below:   

How to Set-Up the OLB: General System Requirements 

Which operating systems are compatible with the OLB application?  
Windows 10 (64-bit) is supported by OTCnet and the OLB.  
 

Which Internet Explorer versions are compatible with the OLB application?  
Internet Explorer 11 and Google Chrome are supported by OTCnet.  

What is the ideal Transport Layer Security (TLS) that should be enabled?  
The TLS 1.2 option must be enabled for all workstations using Windows 10 and higher.  

How much workstation memory is needed?  
At a minimum, 2 GB physical memory is required.  

How much free space is needed?  
100 MB of free disk space is required at minimum. 

How to Set-Up the OLB: Check Processing Requirements  

Which Adobe versions are compatible with OTCnet?  
All versions of Adobe are compatible with OTCnet. Adobe X may require modifications to the web 

browser configuration.  

Which version of Adobe Reader is required at minimum?  
Adobe 7 or higher is required.  

How to Set-Up the OLB: OLB System Requirements  

If you are using Google Chrome, you can skip this step. However, if you use Internet Explorer to 

process checks or card payments, complete the configuration steps below.  

It is highly recommended that OTCnet support staff and users work with their Agency IT Administrator to 

address any Internet Explorer-related configuration challenges. Administrator privileges may be needed.    

How do I configure the Local Intranet zone under the Internet Explorer Security Internet 

Settings?  
Complete the following steps. See Figure 1.  

1. Launch Internet Explorer. 

2. From the Tools menu (refer to the upper right-hand  button), click Internet options. 

3. Click the Security tab. 

4. Select Local Intranet zone. 

5. Ensure the Enable Protected Mode is unchecked. 

6. Click Sites. 

7. In the Local Intranet window, click Advanced. 

8. Enter *.otcnet.for.fiscal.treasury.gov in the Add this website to the zone field. 

9. Click Add. 

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
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10. Enter *.otcnet.fms.treas.gov in the Add this website to the zone field and click Add. Skip this 

step if it already exists.  

11. Click Close.  

Note: Ensure other OTCnet specific websites, such as www.otcnet.for.fiscal.treasury.gov,  
www.otcnet.fms.treas.gov or https://doc.ssologin1.fms.treas.gov, are not included in the Local intranet 

Websites listing. 

 

Figure 1. Local Intranet Configuration 

 

 

 

  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo
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How do I configure the Internet Explorer Compatibility View settings? 
Complete the following steps. See Figure 2.  

1. Launch Internet Explorer. 

2. From the Tools menu (refer to the upper right-hand  button), click Internet options.  

3. Click Compatibility View Settings. 

4. Under the Websites you’ve added to Compatibility View, remove treas.gov and treasury.gov 

if it listed. 

5. Ensure the Display intranet sites in Compatibility View is unchecked. 

6. Click Close.  

 

If you are using Google Chrome, you can skip the steps listed above. However, if you use Internet 

Explorer to process checks or card payments, complete the configuration steps below.  

 

Figure 2. Compatibility View Settings Configuration 
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When creating the OLB Profile and saving the INI file, can you rename it to the user’s name? 
No, the INI file name must remain the same as it was generated. If the file name is changed, the OLB 

application will not run.  

 

How do I verify that the OLB certificate was successfully installed?   
Complete the following steps. See Figure 3.  

1. From the Windows Start menu, launch the Control Panel. 

2. Click Internet Options. 

3. From the Internet Properties window, click the Content tab. 

4. Click Certificates. 

5. From the Certificates window, click the Trusted Root Certification Authorities 

tab. 

6. Confirm localhost is listed.  

7. Click Close. 

Figure 3. Verification of OLB Certificate Installation 
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How do I install the OLB certificate for all Windows users on a workstation?  

If you have several Windows users who use OTCnet check capture on the same workstation, 

the following “mmc.exe” approach may be more efficient. You must be a workstation 

administrator or have workstation administrator privileges to install the Certificate for all 

Windows users on the workstation. There is no impact to OLB functionality if you choose one 

method over the other. 

Complete the following steps. See  

Figure 4 - Figure 11. 

1. Click the Start button to view the search box.  

2. Type mmc in the Windows search box on the lower left of your screen.  

3. Right-click mmc.exe (or mmc) and select Run as administrator. 

4. Enter your workstation administrator credentials as necessary and click Submit.  

 

Figure 4. Windows Search box and User Account Control box 

 

  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo


OTCnet Local Bridge (OLB) 
Configuration and Setup Guide 

 

13 
 

5. The Console 1 dialog box appears. Select File>Add/Remove Snap-in. 

 

Figure 5. Console 1: File>Add/Remove Snap-in... 

 

6. The Add or Remove Snap-in dialog box appears. Under Available snap-ins, 
select Certificates, then click Add. 

 

Figure 6. Add or Remove Snap-in dialog box with Certificates Snap-in and Add button highlighted 
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7. The Certificate snap-in dialog box appears. Click the Computer account radio 
button and click Next. 

8. Click the Local computer radio button, then click Finish. 

9. Ensure that Certificates (Local Computer) appears in the right pane under 
Selected snap-ins and click OK.   

 

Figure 7. Console Root>Certificates shown in Selected snap-ins  

 

10. In the left pane, drill down or click Certificates (Local Computer) and navigate 
to Console Root>Certificates (Local Computer)>Trusted Root Certification 
Authorities>Certificates. 

 

Figure 8. Console Root>Certificates (Local Computer)>Trusted Root Certification Authorities>Certificates 
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11. Right-click on Console Root, Select Certificates (Local Computer)>Trusted 
Root Certification Authorities >Certificates. Select All Tasks>Import… 

 

Figure 9. Select All Tasks>Import… 

 

12. The Certificate Import Wizard displays. Click Next. 

13. Click Browse... and navigate to the location of OLB certificate file 
(olb.otcnet.public.crt). The file is located in the “C:\Program 
Files\OTCnet_olb\keystore” folder.  

14. After the OLB certificate file is selected, click Open. 

 

Figure 10. Open dialog box showing OLB certificate selected 

 

15. Click Next. 

16. Verify that the option Place all certificates in the following store radio button is 
selected and the Certificate store displayed is Trusted Root Certification 
Authorities. Click Next. 
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Figure 11. Certificate Store box 

 

17. The Certificate Import Wizard dialog box displays. Click Finish.  

18. “The import was successful” dialog box appears, click OK. 

19. Close the Console application. You will be asked to “Save console settings to 
Console1?” Click No and the application will exit. You have completed 
installation of the OLB certificate to the workstation; the OLB certificate is now 
available to all Windows user profiles on the workstation. 
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How do I know if the OLB was successfully installed?  
Confirm installation by checking the following areas:   

 Check Desktop for Start OTCnet Local Bridge and Stop OTCnet Local Bridge icons. See 

Figure 12.  
Figure 12. Start and Stop OTCnet Local Bridge Desktop Icons 

 

 

 Under All Programs from the Windows Start dropdown, confirm Start OTCnet Local Bridge 

and Stop OTCnet Local Bridge are listed. See Figure 13.  

 
Figure 13. Start Menu - Start and Stop OTCnet Local Bridge 

 

 Under Programs and Features from the Control Panel, ensure that the OTCnet OLB is listed. 

See Figure 14. 
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Figure 14. Programs and Features - Listing of Installed Programs 
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How to Create an OLB Profile 

How do I know if I successfully imported my OLB credentials? 
After uploading the appropriate INI file, a confirmation window should appear. See Figure 15.  

Figure 15. Successful User Profile Import Confirmation Window 

 

How do I change my OLB password? 

Complete the following steps. See Figure 16.  

1. After logging into OTCnet Online, click the Administration tab. 

2. Select Manager Users. 

3. Click Create Local Bridge and User Profile. 

4. Ensure Online Local Bridge version 2.2.0 or newer radio button is selected. 

5. Enter a password in the Enter Local Bridge/Offline Password* field. 

6. Enter same password in the Confirm Local Bridge/Offline Password* field. 

7. Click Submit. 

8. Save the INI file.  
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Figure 16. Change OLB Password 

 

 

After changing my OLB password, do I need to import my OLB credentials again?  
Yes, Check Capture, Check Processing and Card Processing users will need to import their OLB 

credentials after changing their OLB passwords.  

  

https://www.otcnet.fms.treas.gov/otcnet/views/home.xhtml?_vt=&_home_source_=logo


OTCnet Local Bridge (OLB) 
Configuration and Setup Guide 

 

21 
 

How to Start the OLB  

How do I know if I successfully started the OLB application?  
After entering your OTCnet login ID and OLB password, a confirmation window should appear. See 

Figure 17. 

Figure 17. Successful Login Confirmation Window 

 

What should I do when I see the OTCnet Configurable Options window?  
After logging into the OLB application and OTCnet Online, users will need to select the OTCnet Local 

Bridge Application – OLB radio button from the OTCnet Configurable Options window. See Figure 18.  

Figure 18. OTCnet Configurable Options Window 

 

Note: If a user clicks the OTCnet Local Bridge Application – OLB radio button in error before the OLB 

has been set up, the following steps will reset the system to display the Java Applets/OTCnet Local 

Bridge Application dialog box where the user can then click the Java Applets radio button: 

1. Log into OTCnet. 

2. While logged into OTCnet, copy and paste the following hyperlink: 

https://otcnet.fms.treas.gov/otcnet/views/resetSplash.xhtml into the Internet Explorer address bar 

and press Enter on the keyboard. Ensure the ‘S’ in Splash is capitalized.  

3. Click OK. See Figure 19. 

Figure 19. Message from webpage 
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4. The user will now see the Java Applets/OTCnet Local Bridge Application Dialog Box on return to 
the login page. The defaulted option is now Java Applets, users can click OK and proceed as 
normal.  

  

How do I know if the OLB application is running?  
After logging into OTCnet Online, check to see if the OLB Communication status bar appears on the 

Check Scan page. See Figure 20.  
Figure 20. OLB Communication Status Bar 

 

What should I do if the OLB Communication status bar is not showing up on the Check Scan 

page?  
Only the Check Capture Lead Operator (CCLO) and Check Capture Operator (CCO) will see this 

indication on the Check Scan page once the OLB set up is successful. If you are a CCLO or CCO and 

you do not see the Communication status bar, check your OLB system requirements, specifically your 

Internet Explorer Internet options and Compatibility View settings. Ensure the Trusted Sites zone, 

Local Intranet zone, and Compatibility View settings are configured correctly.  

Review the following available resources:  

• The OTCnet System Requirements and Reference Guide (page 4):  

https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf  

• In this Guide, Section V: OLB Troubleshooting: How to Setup the OLB: OLB System 

Requirements 

What should I do if I encounter a terminal configuration message?  
See Figure 21.  

Figure 21. Terminal Configuration Message 

 

New terminals or those newly updated may need to be reconfigured. Refer to the Configuring Check 

Capturing Online: Configure a Check Capture Terminal Online PJA: 

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_configure_a_chk_term.pdf 
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What should I check if the OLB application is not connecting to OTCnet Online?  
Complete the following steps. See Figure 22.  

1. Sign into the Start OTCnet Local Bridge with OLB credentials.  

2. Log into OTCnet Online. 

3. Press F12 on the keyboard. 

4. From the Developer Tools pop-up, click the Console tab. 

5. Copy and paste the following into the input textbox: 

ws = new WebSocket('wss://localhost:9043/websockets/olb'); 

ws.onopen = function(){ alert("OLB Connection opened successfully")}; 

ws.onerror = function(e){ alert("Error connecting to OLB" +e)}; 

6. Click the green arrow.  

7. Ensure a Message from the webpage window appears.  

8. Click OK.  

9. Click X to close out the Developer Tools pop-up. 

 
Figure 22. Troubleshooting OLB Connection to OTCnet 

 

If an error message appears, the OLB connection is not working properly. See Figure 23. 

Figure 23. Security Message Error 

 

Confirm proper installation of the OLB Setup by:   

 Ensuring all general system requirements are met  

▪ Windows 10 

▪ Google Chrome or Internet Explorer 11  

▪ Installation of Entrust Certification Authority – L1K 

▪ Installation of Root Certification Authority – G2 
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Note: The above Certification Authorities are installed by system default.  

 

 Ensuring all check processing requirements are met  

▪ Firmware 4.3.0  

▪ Adobe Reader 7 and higher  

▪ Installed Scanner Drivers  

 

 Ensuring all OLB system requirements are met 

▪ Configuration of the Trusted Sites zone under Internet Explorer Security settings 

▪ Configuration of the Local Intranet zone under the Internet Explorer Security settings 

▪ Configuration of the Internet Explorer Compatibility View settings  

▪ Installation of the OLB Certificate  

▪ The default port settings were utilized (during execution of the OLB application installation 

file) 

• The default server WSS ports are 9043, 9143, 9243, 9343 and 9443. It is recommended 

to use the default server port settings during the OLB installation process. 

• Other alternative default server ports are 44338, 9042, 9043, and 45823. See Figure 24. 

Figure 24. Server Port Settings 

 

 Reviewing other security settings, such as firewall programs, user permissions, group policy 

settings, etc. are not interfering with access and usage of the OLB application. 

▪ Verify any permissions and/or access restrictions 

▪ Ensure the OLB application and its ports are not blocked by a local security program or 

firewall settings  

▪ Confirm whether users have proper permissions on the local computer to connect to the OLB 

application  

▪ Determine whether the same OLB connection issues are experienced by other users on the 

shared workstation  

▪ Check Agency Group Policy settings 

▪ Ensure the required Internet Explorer sites (i.e. *otcnet.for.fiscal.treasury.gov and 

*.otcnet.fms.treas.gov) are not being blocked. 

▪ Review the OLB logs for additional information 

• OLB log files are located on the local computer in the following folder: C:\OTCnet_olb\log 

Note: Agency IT Administrator may need to provide support.  
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SECTION VI: OLB FREQUENTLY ASKED QUESTIONS (FAQS) 
Explore the following FAQs regarding the OLB transition, configuration and set-up. 

Prepare for the OLB Setup 

Do Deposit Processing users need to use the OLB?  
No, the OLB only impacts check processing and capturing activities. All Check Processing and Capturing 

users will need to set up their workstations with the OLB.  

How will the OLB impact Check Capturing and Processing activities?  
The OLB does not change OTCnet’s functionality or capabilities. Rather, the OLB removes OTCnet’s 

dependency on Java Applets and improves the user experience with faster terminal detection.  

Who do I contact to find out who my Agency POC is? 
Send an email to the OTCnet Deployment Team at fiscalservice.otcdeployment@citi.com to inquire. In 

the email, include your full name, agency and bureau and any other pertinent information.  

How do we check which version of firmware we have?  
 

For Windows 10 users:  

1. Click Start. 

2. Click Window Settings. 

3. Click Control Panel. 

4. Click Programs. 

5. Locate OTCnet Firmware.  

6. Refer to the Version column to determine installed version.  

 

Do I need to update my Firmware to download the OLB? 
Yes, Firmware 4.3.0 is needed to download and use the OLB 2.2.0.  

Which check scanners are compatible with the OLB? 
All scanners currently supported by OTCnet are compatible with the OLB. OTCnet currently supports the 

RDM EC 7000i, RDM EC 9100i, the Panini I: Deal, and the Panini VisionX scanners. Please note that the 

RDM EC 7000i is no longer available for purchase. Please see the OTCnet System Requirements Guide 

for a full compatibility matrix. Contact Customer Support if you encounter issues with your compatibility. 

Is the OLB compatible with Windows 10 64-bit?  
Yes, the following Operating Systems are supported by OTCnet:  

• Windows 10 (OTCnet supports the 64-bit version of the operating system)  

Is the OLB compatible with Microsoft Edge or other internet browsers?  
OTCnet supports Internet Explorer 11 (both 32-bit and 64-bit versions) and Google Chrome. 
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Install the OLB Application 

Can only Check Capture Administrators and Card Administrators download the OLB application 

and certificate? 
Yes, Check Capture Administrators and Card Administrators are the only authorized users who can 

download the OLB application and certificate.  

Do Check Capture Administrators and Card Administrators need to have Windows Administrator 

privileges to download the OLB application and certificate?  
No, Check Capture and Card Administrators do not need to have Windows Administrator privileges to 

download the OLB application and certificate.  

Who can install the OLB application installation package?  
Any Check Capture, Check Processing, or Card Processing user (e.g., Check Capture Administrator, 

Check Capture Supervisor, Check Capture Lead Operator, or Check Capture Operator) can install the 

OLB application installation package. Administrator privileges are needed to install the OLB application. It 

is highly recommended that users work with their Agency IT Administrator to complete installation of the 

OLB application.  

Do users need to have Windows Administrator privileges to install the OLB application?  
Yes, depending on an Agency’s system and security set-up, most users will likely need to have Windows 

Administrator privileges. It is highly recommended for users to work with their Agency IT Administrator to 

complete installation of the OLB application.  

We have multiple users using the same workstation, and each user has a different login. Does 

the OLB need to be separately installed? 
With OLB 2.2.0, the OLB only needs to be installed once as it will install for all Windows profiles. 

However, the certificate will need to be installed for each Windows profile. To install the certificate, it is 

highly recommended for the Agency IT Administrator to use the mmc.exe approach to install the OLB 

application for multiple users on a shared workstation. If you can’t use the mmc.exe approach, then you 

can navigate to the “olb.otcnet.public.crt” file, double-click on it to view the certificate and then click the 

“Install Certificate…” button to run the Certificate Import Wizard. This allows you to import the certificate 

into the “Trusted Root Certification Authorities” certificate store for each Windows profile where the 

certificate is not installed. Please reference pages 12-16 on how to install the OLB certificate for all 

Windows users on a workstation. 

Can a user with multiple roles, such as Check Capture Administrator, Check Capture 

Supervisor, Check Capture Operator, Card Administrator, or Card Operator download and 

install the OLB application and certificate? 
Yes, a user must be a Check Capture Administrator or Card Administrator to download the OLB 

application. However, any Check Capture user (i.e. Check Capture Administrator, Check Capture 

Supervisor, Check Capture Lead Operator, Check Capture Operator) or Card Processing user (Card 

Operator) can install the OLB application if they have Windows Administrator privileges. It is highly 

recommended for users to work with their Agency IT Administrator if they do not have Windows 

Administrator privileges.  

 

With OLB 2.2.0, the file contains the OLB application installer file (EXE file and the certificate. You do not 

need to install the certificate.  
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Create an OLB Profile 

Who needs to create an OLB profile? 
All Check Processing, Check Capture, and Card Processing users need to create an OLB profile.  

Also after the OLB application is installed, will users be able to create and import their own OLB 

credentials? 
Yes, once the OLB application and certificate are installed, users can create and import their own OL B 

credentials.  

Does each user need to create an OLB profile on a shared workstation?  
Yes, each user needs to create their own individual OLB profile to access and use the OLB application on 

the shared workstation.  

Does my OLB password need to match my OTCnet Online password? 
No, OLB passwords do not need to match users’ OTCnet Online passwords. 

Do I need to change my OLB password if I changed my OTCnet Online password? 
No, OLB passwords are not linked to users’ OTCnet Online passwords.  

 

How often do I need to change my OLB password?  
OLB passwords never expire. They do not need to be updated.  

Start the OLB  

Is there a way to turn off the message (Java Applets/OLB Dialog Box) that pops up every time 

we login on the other terminal? 
The Java Applets/OLB dialog Box will continue to appear for Check Capture and Check Processing 

users who have not yet installed the OLB application. Once the OLB application is installed, users can 

select the OLB radio button from the Java Applets/OLB Dialog Box. When the OLB radio button is 

selected, the Java Applets/OLB Dialog Box will no longer appear. Users should continue to select the 

Java Applets radio button until the OLB application has been installed.  

Do I need the OLB to configure a check capture or card terminal?  
Yes, if you are configuring a check capture or card terminal, you must first start the OLB application. If 

you have not started the OLB application, you will receive the following message: “Terminal detection 

failed. Please ensure that the OLB application is running.”  

When do I need to log into the OLB application? 
The OLB application is required to perform terminal configuration, Check Processing, Check Capture, and 

Card Processing operations. If you are a Check Capture Administrator, Check Capture Supervisor, Check 

Capture Lead Operator, Check Capture Operator, Card Administrator, or Card Operator, the OLB 

application must be started on the terminal to performing these operations. There is no “timeout” with the 

OLB application (i.e., a suspension or break in OTCnet activity). Therefore, the OLB application will stay 

connected unless one of the following occurs:  

• The user logs out of the workstation (Windows session)  

• The terminal is turned off, restarted, or rebooted  

• The user stops the OLB application on the terminal 
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SECTION VII: ADDITIONAL RESOURCES 

Helpful Links 
OTCnet FAQs: 

https://www.fiscal.treasury.gov/otcnet/faqs.html    

OTCnet OLB Information and Resources:  

https://www.fiscal.treasury.gov/otcnet/local-bridge-information-resources.html 

 

OTCnet System Requirements and Reference Guide:  

https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf  

OTCnet OLB Fact Sheet: 

 https://www.fiscal.treasury.gov/files/otcnet/OTCnetLocalBridge(OLB)FactSheet.pdf 

OTCnet OLB Information Webinar Presentation 

https://www.fiscal.treasury.gov/files/otcnet/OTCnetLocalBridge(OLB)WebinarPresentation.pdf 

OTCnet OLB FAQs Sheet:  

https://www.fiscal.treasury.gov/files/otcnet/OTCnetLocalBridge(OLB)RolloutFrequentlyAskedQu

estions.pdf 

Training Resources  
Role Web-Based Training 

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/course_OTC/index.htm 

 

All Training Modules  
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/course_OTC/menu_all.htm 

 

On-the-Job Resources and Simulations  
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/course_OTC/menu_all_sims.htm 

 

Topics to review:  

• Download Firmware 
o PJA:  

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_download_fir
mware.pdf  

• Install Firmware 
o PJA:  

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_install_firmw
are.pdf  

• Start and Stop the OTCnet Local Bridge (OLB) Application  
o PJA:  

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/905/sims/pja_start_stop_ol
b.pdf 

o Simulation:  
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/905/sims/44010/index.html 

• Download the OTCnet Local Bridge (OLB) Application 
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o PJA:  
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_download_ol
b.pdf  

• Install the OTCnet Local Bridge (OLB) Certificate 
o PJA: 

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_install_olb_c
ertificate.pdf  

• Install the OTCnet Local Bridge (OLB) Application 
o PJA:   

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_install_OLB.
pdf x 

• Create the OTCnet Local Bridge (OLB) Profile 
o PJA:  

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_create_olb_
profile.pdf  

o Simulation:  
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/44392/index.html  

• Import OTCnet Local Bridge (OLB) Credentials 
o PJA:  

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_import_olb_c
redentials.pdf  

o Simulation:  
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/44402/index.html 

• Configure a Check Capture Terminal 
o PJA:  

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/910/sims/pja_configure_a
_chk_term.pdf 

• Log into OTCnet Online  
o PJA:  

https://www.fiscal.treasury.gov/otcnet/training/wbt/content/905/sims/pja_log_on_otcn
et.pdf 

User Guides  
https://www.fiscal.treasury.gov/otcnet/training/wbt/content/course_OTC/library.htm  
 

SECTION VIII: ADDITIONAL SUPPORT 
For further assistance, reach out to the following support staff:   

OTCnet Deployment Team -  Please contact at 1-866-945-7920, option 4, or 

FiscalService.OTCDeployment@citi.com if your agency is currently in the OLB rollout testing 

phase and you need assistance with initial OLB testing.  

 

OTCnet Customer Support Team - Please contact at 1-866-945-7920, option 2, or 

FiscalService.OTCChannel@citi.com if your agency has already successfully tested the OLB 

application and you need assistance, or if you have any general questions. 
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